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Analysis using Craig-Bampton reduced model

1. Free vibration analysis
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PROCEDURE
1. Create Keypoints
Command : POINT,ADD
Menu : Geometry = Keypoint = Create = By X/Y/Z

Parameters :

Coordinate data | 0/0/0
Coordinate type | 0
Entity ID
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At the end of the operation your screen should look like this.

43 PreWin 2017R2 (PROFESSIONAL VERSION) = e
| Fle Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help |

oR&s S#REM™ o - [BoO00|yE ocxoaD smuBa o5

| Main] Edit| Show] Colour] Setting;] [
J. |&2 commands ] éé;
el | B =]
el F = 5&0Kme?'_ . PreWin 2017R1 Betab
mf|| P8 KeyPoin VSSC/ISRO
=[] Create
e D ByXVZ
= [> OnPlane
ﬂ_ ~[» Snap
_°J +[] On Geometry
= Copy
ﬂ #] Move &)
ﬂ #[] Miscellaneous
| & Curve -
g # [ Surface
# 3 Volume
@ >
—‘—J (] Plane _.:]
]|
|
il
POINT,ADD
L] | -
al Coordinate data W
(]
Coordinate Type |0 3
e | Lx
| Entity D I
= Command: POINT,ADD
) I POINT,ADD - Done !
¥ Autokx Lt
‘ R —J Command: POINT,ADD

| Rea;ﬂy.

Similarly create a point at (300/30/0)
2. Create Surface
Command : SURFACE,RECT2
Menu : Geometry —> Surface > Create = Rect2P

Parameters : SURFACE,RECT2P

Corner Points |F'1_a'F'2 M

Cutput ID |
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At the end of the operation your screen should look like this.

45 PreWin 2017R2 (PROFESSIONAL VERSION) e ]
|| Fle Edit View Geometry Mesh Load/BC Property Analysis Seftings Post Help '

i

loZeglaREm o~ | ||Boou | vE| oalcapo| sail Ba &5 ¢ I
— |
|

Main| Edit] Show Colour| Settings|

Labels it [ PreWin 2017R1
Ba_ckgfound Gl u VESC/ISRO
Paint Mode =
Shading Surface !l
Colour List Curve !|
Point !|
Plane | |
LCS | |
DispConstraint !:
Pressure ! _____________________________ e e e et
Force | | ﬂ :

Customl Load.. lSture.. |

SURFACE,RECT2P

Corner Points |P1,"P2 M b
o

Cutput ID I

B 2| (ols |lo|2|s (0] @] |2 (9] ]|

POINT ADD - Done ! -
Command: SURFACERECT2P
SURFACERECT2P - Done ! EI

|l'~7 AutoExec App

Command: SURFACERECT2P

= = T - |
I Select all active objects not inluded in selection window Select: Point |
Sistfy]

3. Generate mesh

Command : FEM,QUAD
Menu : Mesh > FE Mesh > QUAD

Parameters :
FEM, QUAD

Surface Il El
Initial Size [10.8051 By

Method  Pawver — |

Type 4-Node — |

Divisiens I [z

Bias I M
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At the end of the above operation your screen should like this

4 PreWin 2017R2 (PROFESSIONAL VERSION) =[]
| File Edit View Geometry Mesh Laad;’BCﬁ Property  Analysis Settmgsr Post Hﬁelp

DAASEROR e | BOOD| yE Ta oD e[ Ea 05

- Col .
Mami Ed\t! Shﬂ\nrf ol OUfl Settmg;] ”:E
- o
obiects | [ ]
Labels EleFaRE ] PreWin 2017R1
Background Vol n VSSC /ISRO
Paint Mode g
Shading ke L
Colour List Curve n
Point | |
Plane B
LCS | |
DispConstraint 1l
Pressure | |
i Force u -
Elack1 Whitel Cu;tnm] Load.. | Store.. I I

FEM.QUADAUTO _
swfce 1 L g

Bemsie 08051 L Lx
Diisions [sLO®6 b
e [ b

i zlelols g2l iol: Bl-ls [Blal] |

SURFACE,RECTZ2P - Done ! =]
Command: FEM,QUADAUTO
FEM,QUADAUTO - Done |

J!‘J AutoExec App!
Command: FEM,QUADAUTO

| Ready. | Select: Surface

Ll

4. Erase Surface
Command : SURFACE,ERASE
Menu : Geometry > Surface - Miscellaneous - Erase

Parameters : SURFACE,ERASE

Surface [Ds | M

Enter the surfase ID in the box or pick the curve using mouse pointer.
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At the end of the above operation your screen should like this

€5 PreWin 2017R2 (PROFESSIONAL VERSION)
” File Edit W¥iew Geometry Mesh Load/BC Property Analysis Settings Post Help

|logeaaRadnl-||oou/sB o aD|s wnEas @5

Main| Edit| Show Colour] Settings|

o
Noie W
Labels Element u PreWin 2017R1
Background I VS8SC [ISRO
y Volurme | |
Paint Mode —=¢
Shading Siifece L
Colour List Curve | |
Point !
Plane | |
LCs |
DispConstraint [l
Pressure | ]
Force m

Black] White| Custom| Load.. | store.. |

SURFACE ERASE

Surface IDs | M i

L.

B gl |els oz O] HElx|g|9]s]]-

FEM.QUADAUTO - Done ! |
Command: SURFACE ERASE
SURFACE ERASE - Done ! j
|!7 AutoExec Apply
——— | Command:
iReady‘ Select: Surfaces 4

5. Create Brick Element
Command : ELEMENT,EXTRUDE
Menu : Mesh - Element - Create - Extrude
Parameters : ELEMENT,EXTRUDE

Element IDs IALL— EI
Extrude-Vector I[JJTJ[—].E— EI
Scale Factor 111

Angle IU—
Segments |4—
Delete Flag ON —

Reference Point W EI
Output ID I—
MNode cutput ID I—
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At the end of the above operation your screen should like this

4 PreWin 2017R2 (PROFESSIONAL VERSION]

|| File Edit View Geometry Mesh Load/BC Property Analysis Seftings Post Help |

P& & @ RO o

W COFOUfiSettingsl v:;B
Node m 5 ki
Labels i u PreWin 2017R1
Background T ;I VYSSC/ISRO
Paint Mode =
Shading Sk L
Colour List Curve | |}
Point | |
Plane !|
LCs | |
DispConstraint Wl
Pressure | |}
Force m =
B}ack!Whlte! Custom! Load.. | Store.., I

ELEMENT,EXTRUDE
HlementiDs AL |
Butrude-Vector [0/0/-12 |
Scale Factor ilr”l/l
Angle o
Segments |4
Delete Flag ON — | &
Reference Point ICl:O:O:O _[EJ X

Qutput 1D I
Nede cutput ID i
sl SURFACE,ERASE - Done! :!

Command: ELEMENT EXTRUDE
ELEMENT,EXTRUDE - Done !

e [ |e|e]s |#|Bs O Bl|e o]

Ll

¥ AutoExec Appl
— 1 | Command: ELEMENT EXTRUDE

! Ready.

Create the projected mass portion by following method

Command : ELEMENT,CTRAN
Menu : Mesh-> Element-> Copy—> Translate

Parameters : ELEMENT,CTRANS

Element IDs Im M
Distance |3—
Direction IZ— EI
Mo, of copies IQ—
Qutput ID I—
Mode eutput ID I—
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At the end of the above operation your screen will look like this.

@ PreWin 2017R2 (PROFESSIONAL VERSION)
File  Edit  Miew Geometry Mesh  Load/8C  Property  Analysis  Settings  Post  Help

S ASERGHR > - |[BoOHl B G~ ah0 swiEa &0

o 1 pamin Ecit| snow| Colour] Semings| B
% hern | Sets @
Ll AnType EZNN || Prewin2017R1
= VSSC/18R0
u
@l
|
LE2]
4]
(e]
2| Edx | Dotete
L]
Wl
ﬂ ELEMENT,CTRANS
ﬁ BementDs  [I5TI36/20TH2T2T |
Dustance 3
H Direction liig,l
Bll| wo ot copies o
|| owpam
Mode output 10
&
NODESHOW - Done | |
‘Cormemand: ELEMENT, CTRANS
ELEMENT,CTRANS - Done | =
e A 268 ]| cormmans: SSVENTETNNS

6. Merge Nodes
Command : NODE,MERGE
Menu : Mesh-> Node-> Modify-> Merge

Parameters : NODE,MERGE

NodeIDs Al ﬁl

Tolerance IEI 0001
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7. Apply Boundary Condition

Command : BC,ADD

ol =
Menu : Load/BC - Displacement BC > Add T
¥ Ux iﬂ_ Cancel
Node IDs [2417245/247T26382/975T977, El Fulo

W Uz |n
BCvalue [1/0/2/0/3/0

LCS ID IU El - Rotation
setlD | ™R g
I Ry IU
™ Rz Iu

Parameters :

At the end of the above operation your screen will look like this.

' 45 PreWin 2017R2 (PROFESSIONAL VERSION) =

| File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help |
o & @ R o | OO vE e e O el FEa 9L
—{| ain Edit| show] Colour| Settings] %}»

Ttem Sets
AnType PreWin 2017R1
VSSC/1SRO

I Edit | Delete

| o|e| o @ @ e +|

an|D M| P|T| 1|06 G| x|~
NODE,SHOW

Modemlds [al k]

Colour [ |

I [l ]e s |22 0= @lx & ||| |

¥:

I

DispConstraint SETID = 1 Ux=0 Uy=0 Uz=0 ..:!
Command: NODE,SHOW
MODESHOW - Done!

L

v AutoExec Apply
—— | Command;

iReady. Select: Nodes
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8.

10.

11.

Apply Material Property

Command : MATERIAL,ISO

Menu : Property - Material - Isotropic > Add

Parameters : MATERIAL ISO

ElementIDs |ALL

Material-Data |

Material D |1

B
=)

A_| Material Properties

Madulus of elasticity

Poisson's ratio

Coefft. of thermal expansion

Mass density (RHO)

72000
033
23E-05

Plastic strain Vs True stress

Lead from Library...

Add te Library...

You can enter the material data from 'Load from Library' option or you can manually

type in the required data.
Set Analysis Type

Command : ANTYPE,SET
Menu : Analysis - Analysis Type

Parameters : ANTYPE,SET

Analysis Type Free Vibration —
Set analysis Option
Command : ANOPTION,SET
Menu : Analysis > Analysis Option

Parameters : ANOPTION,SET

Eigen Solver iLanczos —

Pre-stress File

Save the project model

Menu : File - Save
Save the file to desired directory
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12. Submit the job in to FEAST

Menu: Analysis > Run Solver
Click Here

49 PreWin 2017R2 (PROFESSIONAL VERSION) (E=S ol 50

File Edit| View Geometry Mesh Load/BC Property Analysis Settings Post Help
OEFES EROH - | |BOoMD| yE me 8D 8o R

Main Edit| Show| Colour| Settings| @

[ ltem Sets

AnType PreWin 2017R1
VSSC/ISRO
DynsmicGen
Anslysis Option
Waterial

Edit | Delete

ki lelzlol el liolk [@lle [#lsbl|

C|oe e P HE e
an|D|M|P|T| T [n6|G| x|~
BCEDIT e
: T e
Node IDs [2417285/247T26382/9751977, [ | ‘3&{»‘;&'3?:"'
s $ 52 3
BC value [1/0/2/0/3/0 = .'""'*33&;
s o Y|
Iv\x
Command: POST SECTIONCONTOUR 5|
DispConstraint SETID =1 Ux=0 Uy=0 Uz=0
= | BCEDIT - Done ! =
¥ AutoExec f
Command:
[Ready. i Select: Nodes

13. Post Processing

i. View Results
Command : POST,VIEWRESULTS
Menu : Post = View Results

Parameters :

Item |Frequencie5 j

The following table will be displayed
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5| Frequencies

Mode|  Frequency(Hz) 2

] 1 306220

] 2| 758525

[ 3| 205739

] 4 380013

] 5| 511168

] 6 571893

[ 7 106962

] 8 126317

[ 9 134680

] 10| 138.301

] 11 179802 -

] 12| 429

[ 13| 255,347

] 14| 266287

[ 15 364495 -
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Creating Craig —Bampton for the above model

First create a copy of the above geometry by saving it with another name.Then export the
Craig-Bampton elements such that the impacts of those elements are taken into
consideration while analysis but the Craig-Bampton elements are not displayed.

10. CBMATRIX EXPORT

Command : CBMATRIX EXPORT

Menu . Analysis = Free Vibration>CB Matrix = Export
Element IDs Specify the elements to be created as CB
File Name Specify the location to save the CB .pch file
Interface Nodes Select the nodes that interface both the surface
Restitution Nodes Optional
Degree of Freedom 123456

File Edit View Geometry Mesh Load/BC  Property Analysis  Settings Post Help

OF&EE BEROR| « ~ |BoOU| yE e o &0 s == 50 E& H
j. Main | Edit| Show Colour| Settings| e
ﬁ LTSN | Node |
Labels ElsranE n PreWin 2017R1
8| | Background VSSC[ISRO
Volume [ |
:J Paint Mode
|| Shading Surface |
) Colour List Curve | |
ﬂ Point [ |
Plane |
ﬂ LCs |
ﬂ DispConstraint [l
Pressure | | T . T T T
g' Force | x| SESSsses SSSSsss = = = = =
ﬂ EIack|Wh\te] Custom‘ Load.. IStore.. ‘
#
E =LAl A AEA ] L
AllDIM|P|T|[I|G[x| "
A
J CEMATRIX EXPORT
L
Element IDs 144171584 Ly
Kl
File name GATESTING FEAST\ =l X
L I
i Interface nodes _hj
_Ej Restitution nodes M
Command: CBMATRIX EXPORT (=]
ﬂ Degree of freedom |123458 E Command: ANTYPESET
Command: CBMATRL{ EXPORT E]
|f~7 AutoExec Apply
Command:
Ready. Select: Elements
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Interface nodes are selected as shown in figure below

4 PreWin 2017R2 (PROFESSIOMAL VERSION) : e -
File Edit Miew Geometry Mesh Load/BC  Property Analysis  Settings Post  Help

jlodmalamR@n~-@ont/va o~ aao|s-mn

Main | Edit | Show | Colour| Settings o
l_]I'MeLh | Color]setinge - %;
# 1 Load/BC )
(0 Property PreWin 2017R2
=10 Analysis VSSC/ISRQ
[> Analysis Type
[> Analysis Options
[> Title
[» Run Solver

e
=11 Free Vibration
] General
#[] FSlData
=0 CBMatrix
[ Export
[ Import |

cle® e mul +
AlDIM P|T|I|nGG| X ~r

CBMATRIX EXPORT

Element IDs W M
File name im EJ
Interface nodes ]‘]m‘? E-]
Restitution nodes ]m M é

< (g |e» lgZsO= Blxlo o] |

Degree of freedom |123456 @ ¥

X

ELEMENT,ERASE - Done ! :J
ELEMENT,ERASE - Done !

Command: CEMATRIX EXPORT

CBMATRIX,EXPORT - Done! Zj

W AutoExec Apply
Command:

Ready. I Select: Nodes

Restitution nodes are those nodes on the Craig-Bampton reduced portion at which responses are
required to be calculated while solving response analysis problems. In case of free vibration
analysis restitution nodes need not be specified. But here we are doing response analysis also.
Hence, specify the nodes at which responses are to be extracted. In this case select some nodes
from top of the Craig-Bampton reduced portion. Now save the same file as different name. Then
delete the element that has been converted to CB Matrix in this file. At the end of this operation
your screen should look like this.
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|| Eile Edit View Geometry Mesh Load/BC Propetty Analysis Settings Post Help

o &SRO« ~||BOo00 vyE| e el =il Ed &5 0
Edit] ShUW] C,Dlour] Setting;l D)
J +_] Geometry 4 %;ﬁ
|l F1E2 Mesh )
451 FEMesh PreWin 2017R1
| [F o=t VSSC /ISRO
ﬂ =[] Element
+[3 Create
EJ # (1 Modify
_J ([ Copy Ul
=3 Move
Ej 411 Verify
=11 Miscellaneous
ﬂ . [> Delete
[» Find
2 D Show EEzsmmmszmmmemmsmmemmmmmmmmmmmsemmmcommmeemmmmcemmmecommss
2| - || e e e e
L]
u cloe|leee <E  +
AlDM|P|T|I|G|x "=
-
_"J ELEMEMT,DELETE
lTJ Elerment IDs _%J
o8] L"
l] Command: ELEMENT ERASE ﬂ
ELEMENT,ERASE - Done! j
- Command: ELEMENT, DELETE -
|J7 AutoFxec Apply Command:
Ready. [ Select: Elements

Now to verify the Craig-Bampton properties import the CB Matrix written as .pch file follow the
procedure below.

1. CB IMPORT

Command : CBMATRIX IMPORT
Menu :Analysis = Free Vibration=>CB Matrix = Import

File Name Select the .pch file created as CB
LCSId 0
SET Id 1

% Open (=

’\'_' i |« FEAST 2017R1 Tessting » B = [4s ¢ 2|
CEMATRDC IMPORT Oiganize P folder = - Ml @

config “  Name g Date

File name |G:';T ESTING FEASTAWFEAST 20
Lcsio o

i Desktop
SetD Fi_ & Downloads

Lr Favorites

i | 1] cL-Beam-cB 11-09-2017 10:24 PCH Fil
Binl

£ Contacts

# Links
My Documents

A My Music

£ My Pictures

H My Videas =

File name:  CL-Beam-CB + | Text Files(*.pcn) -

Open | | cancat |

W AutoExec Apply |
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2. Save the Project File
Menu . File = Save

3. Submit the file to FEAST

Menu . Analysis = Run Solver

4. Perform post processing
a) Mode Shape
Command . POST, VIEWRESULTS

Menu : Post 2 View results=>Frequencies

5| Frequencies

-

Maode FrequencyiHz) =l
95,3646
236,351
640.74
119711
1594.83
178106
333082
3036.08|
420416
43566
5508.71 L
759329
8036.87
829231
113483 =

Close

iy

(=R R T R TR )

=
(=]

Al i R
[V, IR A R SR S

The above figure shows the frequencies of the model with CB. So from both the analysis i,e from
free vibration of the complete model and free vibration of the model with CB the frequencies are
matching.
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2. Frequency response analysis

After doing free vibration analysis save a copy of the file for frequency response analysis. In the
new file change analysis type to Frequency Response.

1. Specify frequency response general properties.
Commands : FREQGEN,ADD
Menu : Analysis = Frequency Response —» General - Add

Parameter . FREQGEN,ADD

Response Extraction  Auto —

Mo. of modes

Node List | 2536 [y
Start Frequency | 0
Maximum Frequency | 18000
Finer Increment | 1
Coarser Incrernent | 10
Mass Option Lumped —
Stress Option No —
2. Specify damping factor
Commands : EXPFRDAMP,ADD
Menu : Analysis = Frequency Response —» Damping —» Add
Parameter EXPFRDAMP,ADD
B ' Damping Factors X
Damping factors | E‘T_
Frequency{Hz) Factorl Insert Row
T 0.02
- Delete Row
] 10 0.02 B e
| 1000 002| _ Eeste
] 10000 0.0d
L Erom file....
Cancel
| o
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3. Specify the load
Commands : FORCE,ADD

Menu : Load/BC — Point Load » Add

Parameter FORCE,ADD

NodelDs 1893 Y
Dats [100 =

Component Fz <

tso o |

Set ID |

At the end of above operation your screen should look like this.

4% PreWin 2017R2 (PROFESSIOMAL VERSION) . =[]
File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help |
o2& ERO% <« ||[Bomy|/vE| oD »oil Bam &5
j MamlEd\ti Show C0|0U|’]Sel‘tmgsi (@
| Node = =
Labels Emicnt m PreWin 2017R2
=1 | Background = VSSC [ISRO
Volume [ |
LJ Paint Mode
Shading Surface [ |
||| ColourList Curve ||
iJ Point [ |
Plane i
ﬂ LCS ]
ﬂ DispConstraint | |
Pressure 1] -
g Force m _'j =+
2| Black| White| Custom | Load. | stare.. | ‘
Al
v ~|ole|eleemEu[ +
ADMP|T|I|nGG|X ~
|
FORCE,ADD
NodelDs [1883 I
=i D 100 =
t
ol| x
Component Fz —~ |
LcSID 0 Y
|| s« I Command: FORCE,ADD il
FORCE,ADD - Done! j
FORCE,ADD - Done! |
Jv it 4J Command: FORCEADD
Ready. Select: Modes

4. Creating dummy nodes

Nodes having same ID as that of restitution nodes should also be present in the Craig-Bampton
reduced model in order to extract responses. But its co-ordinates need not be the same as that of
the actual nodes. Hence create nodes with same ID as that of the restitution nodes in the reduced
model.
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Commands : NODE,SNAP

Menu : Mesh = Node =+ Create = Snap
Parameter MODE,SMAP
Paint Data | Iz
Entity D |2536

Create as many IDs as you included in restitution nodes.

5. Save the project model
Menu : File - Save

Save the file to desired directory
6. Run solver

Menu : Analysis — Run Solver

7. Perform post processing
a. History plot

Commands : POST,HISTORYPLOT

Menu : Post — History plot

Parameter Item |Acce|erati0n j
Component |TZ j
Nodes | 2536
Complex As |M0du|u5 j
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At the end of above operation you will get the response plot as shown in figure below.

Acceleration:TZ:Modulus

PreWin 2017R2
55C /1

SRO

3.85004e+08
;’rTZ at node 2536 ]

3.5202e+08 |

J

3.20837e+08 |

2.88753e+08

2.56660e+08 |

c o
2..1_;4:386&08

o
1.9302e+08
[sH]

o
1.@13e+03

B .
| et

o
—
—r—— |

1.28335e+08

9.6251e+07

| |

N

6.41674e+07

A

pd

A

—

3.20837e+07

..f_/

T

\//

kY

188088

216096

0 1800.8

3601.6

S402.4

72032

5004

10804.5 12605.6
Frequency
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